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(multi-user version)

IMPORTANT-READ CAREFULLY: This Multi-User License and Warranty Agreement (the “Agreement”) is a legal agreement between you and
SalesLogix Corporation for the software product identified above (the “Software”), which includes computer software and associated media and
printed materials (the printed materials are hereafter referred to as the “Documentation”). By downloading, installing, copying or otherwise using the
Software, you agree to be bound by the terms of this Agreement. If you do not agree to the terms of this Agreement, promptly return the unused
Software to the place from which you obtained it for a full refund. The Software is the property of SalesLogix or its licensors and is protected by
copyright law. While SalesLogix continues to own the Software, you will have certain rights to use the Software after your acceptance of this
Agreement. Except as may be modified by a license addendum which accompanies this Agreement, your rights and obligations with respect to the
use of this Software are as follows:

1. GRANT OF LICENSE. SalesLogix is the exclusive owner of the Software and the Documentation. SalesLogix grants to you, and you accept by
downloading the software or opening the sealed media package, a non-exclusive license to use the Software and the Documentation on the following
terms.

Software. You may install and use one copy of the Software for each user license you have purchased, and you may make one copy of the Software
solely for back-up purposes. If you have paid for and been granted a Workgroup Server or Synchronization Server License, you may install the
Software on a single client server system at any one time. If you have purchased a Synchronization Server License, you may allow remote access to
the Software on the server by that number of remote users for whom you have purchased separate Remote Client Licenses, and no more. If you have
purchased a Workgroup Server License, you may allow access to the Software on the client-server by that number of networked users for whom you
have purchased separate Workgroup Client Licenses, and no more. Upon paying for the Software, you will receive a set of license numbers which,
when entered on the Software, will allow access to the Software by the number of Remote Client and/or Workgroup Client users permitted by your
purchased licenses. You agree not to disclose these key numbers to third parties or attempt to make any use of the key numbers to expand the
number of users who may access the Software in excess of the respective Remote Client Licenses and Workgroup Client Licenses purchased by
you. If you wish to expand the number of users who can access the Software beyond the number for whom you have purchased licenses, you may
purchase additional licenses from SalesLogix, which licenses will take the form of additional key numbers provided to you by SalesLogix.

Transfer. You may permanently transfer all of your rights under this Agreement, provided you retain no copies and transfer all of the Software
(including all component parts, the media and related Documentation, any upgrades, and this Agreement) and the recipient agrees to accept the terms
and conditions of this Agreement.

Restrictions. You may not: use, copy, modify, or transfer copies of the Software except as provided for in this Agreement; reverse engineer,
decompile or disassemble the Software; or rent, lease, sublicense or assign the Software or any copy thereof, including any related documentation.

2. LIMITED WARRANTY.  SalesLogix warrants the media, if any, on which the Software is furnished to be free from defects in material and
workmanship under normal use for a period of ninety (90) days from the date of delivery of the Software to you. Any replacement Software will be
warranted for the remainder of the original warranty period or thirty (30) days, whichever is longer. EXCEPT FOR THE LIMITED WARRANTY
DESCRIBED ABOVE, THIS SOFTWARE IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR
STATUTORY, INCLUDING WITHOUT LIMITATION ANY WARRANTY OF MERCHANTABILITY, TITLE, NONINFRINGEMENT,
THE CONDITION OF THE SOFTWARE, OR FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK ARISING OUT OF THE
USE OR PERFORMANCE OF THE SOFTWARE AND DOCUMENTATION REMAINS WITH YOU. SalesLogix does not warrant the
functions contained in the Software will meet your requirements or that operation of the product will be uninterrupted or error free.

3. LIMITATIONS OF REMEDIES.  SalesLogix’s entire liability and your exclusive remedy shall be: replacement of any diskette not meeting
SalesLogix’s “Limited Warranty” and which is promptly returned to SalesLogix. TO THE MAXIMUM EXTENT PERMITTED BY
APPLICABLE LAW, IN NO EVENT SHALL SALESLOGIX OR ITS SUPPLIERS BE LIABLE TO YOU FOR ANY CONSEQUENTIAL,
INCIDENTAL, DIRECT, INDIRECT, SPECIAL, PUNITIVE, OR OTHER DAMAGES WHATSOEVER (INCLUDING, WITHOUT
LIMITATION, DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION,
OR OTHER PECUNIARY LOSS) ARISING OUT OF THIS AGREEMENT OR THE USE OF OR INABILITY TO USE THE SOFTWARE,
EVEN IF SALESLOGIX HAD BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

4. SUPPORT AND UPDATES. SalesLogix provides maintenance and/or technical support (including upgrades and enhancements) for the
Software only through separate Software Support Agreements. Please contact SalesLogix if you wish to obtain support through the execution of such
an agreement.



5. EXPORT CONTROL. You may not export, ship, transmit or reexport the Software or Documentation in violation of any applicable law or
regulation including, without limitations, the Export Administration Regulations issued by the United States Department of Commerce.

6. UNITED STATES GOVERNMENT RESTRICTED RIGHTS. The Software and Documentation are provided with restricted rights. If you
are purchasing this product for use by the federal government or any of its agencies, you need to enter into a separate restricted rights agreement with
SalesLogix. Use, duplication or disclosure by the federal government is subject to restricted rights as set forth in subparagraph (c)(1)(ii) of The Rights
in Technical Data and Computer Software clause of DFARS at 252.227-7013.

7. GOVERNING LAW.  The validity and performance of this Agreement shall be governed by and construed in accordance with the laws of the
State of Arizona, excluding that body of law applicable to choice of law.

GENERAL.  You may terminate your license at any time by destroying all your copies of the Software. SalesLogix or its authorized distributor may
terminate your license if you fail to comply with the terms and conditions of this Agreement. Upon such termination, you agree to destroy all your
copies of the Software. Should you have any questions concerning this Agreement, write to SalesLogix Corporation, 8800 North Gainey Center
Drive, Suite 200, Scottsdale, Arizona 85258, U.S.A.
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SalesLogix has reviewed this manual thoroughly. All statements, technical information, and recommendations in this manual and in any guides or
related documents are believed reliable, but the accuracy and completeness thereof are not guaranteed or warranted, and they are not intended to be,
nor should they be understood to be, representations or warranties concerning the products described. Further, SalesLogix reserves the right to make
changes to the information described in this manual at any time without notice and without obligation to notify any person of such changes.
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SalesLogix is a registered trademark of SalesLogix Corporation. Other product names mentioned in this manual may be trademarks or registered
trademarks of their respective companies and are hereby acknowledged.
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This book demonstrates how you can use the power of SalesLogix to
convert leads into opportunities and then into sales. As you follow the
scenarios, you’ll learn how to accomplish many of the activities that will
contribute to your sales success. But this represents a small sample of
SalesLogix features. You’ll find comprehensive information about all
SalesLogix features in the online Help. It includes detailed explanations of
SalesLogix concepts, step-by-step explanations of the tasks you’ll want to
accomplish, and descriptions of the items you’ll see in the SalesLogix
windows and dialogs. You’ll rely on Help to quickly get answers to your
questions about SalesLogix.

To open SalesLogix Help, choose Help Topics from the Help menu. You
can browse through topics by category, look through a list of index entries,
or search for words or phrases that may be included in a help topic. To get
help about a specific SalesLogix window or dialog, press F1 with the
window or dialog open; to get help for a specific object within a dialog,
select the object and press SHIFT+F1.

Throughout this guide you’ll see references to Related Help Topics, as
shown in the following table. These references point you to general
information about the concepts and tasks discussed in that section. Double-
click the listed book on the Help Contents tab to open it. Some books
contain other books. Continue to open the books until you see the page
related to the topic you’re interested in. For example, to get general
information about using online Help, open the Getting Started book and
double-click the Using the Help System page. To find information about a
specific topic, go to the Index tab and type the first few letters of the word
you’re looking for. The Help index works the same way as the index of a
book.

���
�����
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Related Help Topics

To learn: Open these topics:

How to use the Help system Getting Started

Using the Help System

����������	
��������

If you are a corporate user, contact your administrator, designated support
person, or SalesLogix certified Business Partner. Please provide the
following information:

♦ Support account number

♦ Version number of your SalesLogix software

♦ Software features you were using when the problem occurred

♦ Text of the error message you received (if applicable)

♦ Operating system (Windows 95 or NT)

♦ SQL database name and version

You can also check the FAQs (frequently asked questions) on the
SalesLogix web page at www.SalesLogix.com.

Related Help Topics

To learn: Open these topics:

How to contact SalesLogix Getting Started

Contacting SalesLogix
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It’s your first day on the job. You’ve filled out the paperwork with HR
to make sure you get paid, been through employee orientation and your first
software training class, found the coffee and the restroom, and been left to
your own devices until you meet with your manager. This is a good time to
take a look at your new tools and see if you can remember what you
learned in class. Maybe you can also find out when you are scheduled to
meet with your boss.

��� ���� ��	
�����

If SalesLogix is not already running, you’ll need to log on to the system.
Before you begin, find the UserId and password you were given during
training. If you don’t have a UserId or password, contact your system
administrator.

�� Click  and point to Programs.

�� Point to SalesLogix and choose SalesLogix Client from the menu.

�� Enter your UserId and password and click OK.

�� Select the database you are going to use from the drop-down list.
(Your company may have a single database or several. Generally,
there will be one “real” database and others for testing or training.)

SalesLogix displays one of its main windows. These windows are called
views in SalesLogix. You change from one view to another by clicking the
icons on the navigation bar at the left side of the view.

�
��	����

SalesLogix is designed
to be customized to
meet your company’s
specific needs. If your
SalesLogix windows,
dialogs, menus, and/or
toolbars were
customized for your
company, the
illustrations you see in
this guide may not
match what you see on
your computer screen.

To change the start-up
view, select Options
from the Tools menu.
On the General tab,
select the view you
want from the Show On
Startup drop-down list.
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�� Click  on the navigation bar.

�� When the calendar opens, if you are in the Day or Week view,
check the timeline area to see when the meeting with your manager
is scheduled. If you are in the Month or Year view, check the
Activities area.

You find your meeting scheduled for a late lunch in 15 minutes. Your
stomach confirms the appointment. But you still have a few minutes of free
time. How about setting up your calendar to match the way you work?

��� ��	
 ������
 �
���
����

Your calendar defines your work week by showing some areas in white and
other areas in gray. Some people may work from 8 to 5 Monday through
Friday, but those are certainly not your hours. You need a broader time
range to accommodate clients in different time zones, and there will surely
be some weekends that you’ll need to schedule appointments. No
problem—you can adjust your calendar display to match your schedule.

�� Click the Week tab in the Calendar view. (You can set preferences
from anywhere in SalesLogix—this takes you directly to the
Calendar options.)

�� Right click and choose Options from the shortcut menu.

�� On the Calendar tab of the Options dialog, define your work week
by selecting the check boxes for the appropriate days in the Work
Week area.

�� Define your workday by
entering Day Start and Day
End times in the Calendar

Display area. Click  in
each field and drag the slider
bar to the starting and
ending times you want.
Click OK when the correct
time is shown.

�� Click OK to close the
Options dialog.

You can also open the
Options dialog by
choosing Options from
the Tools menu in any
SalesLogix view.
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The time period you set for each selected day is displayed with a
white background in your calendar; days and times outside your
selection have a gray background. You can schedule activities in
both the white and gray areas.

You probably noticed many other options on the Calendar tab.
You use the items on each tab of the Options dialog to customize
SalesLogix. For additional information, check the Related Help
Topics at the end of this section.

�������� ��	 ����
���

Your prospects and customers are called contacts and accounts. Accounts
are companies that can contain one or many contacts. Potential sales to
accounts and contacts are called opportunities. You can associate the key
contacts involved in a potential sale with an opportunity.

SalesLogix tracks your daily interactions with contacts, such as phone
calls, meetings, to-do’s, correspondence, and more. You can view and
report on these tasks from an account, contact, or opportunity perspective.

You can work with your contacts and accounts in a table format using the
Contact List view and the Account List view, or see in-depth information
about one contact or account at a time in the Contact Detail view and the
Account Detail view.

Your access to accounts and account-related information depends upon the
type of account and your access rights. For information about your access
rights, check with your system administrator.

There are two types of accounts: public and personal.

Public accounts and their associated contacts are visible to all users with
access rights to the account. These accounts can be owned by individual
users, teams of users, or everyone.

Personal accounts and their associated contacts are owned by the user who
enters the contact and can only be viewed by that user. When you enter a
personal contact, an account is created using the contact name and your
name displays in the owner field. Your ability to add personal contacts
depends on your access rights.

If you are a remote user, you can choose the accounts you want to store on
your local database using subscription. You automatically subscribe to
accounts you own as an individual or as the primary team member.
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As noted earlier, you can look at one line of information about many
contacts or detailed information about a single contact. Take a minute to
become familiar with the information displayed in each view.

The Contact List view displays a single line of information about each
contact in the list. You can customize the information displayed in the
Contact List view to fit your needs, including items such as contact name,
account name, city, state, work phone, and so on. Click the tabs in the
Contact List view to see a group of contacts.

The Contact Detail view contains in-depth information about one contact at
a time. The Detail view has three sections:

♦ The top section shows detailed information about the selected
account. To edit the data, click the box you want to change.
Right click to see the shortcut menu.

♦ You can use the section in the middle to display the tab you
use most often. Select a tab from the bottom of the view and
drag it into the middle of the view.

♦ The Contact tabs are at the bottom of the view. Click a tab to
see detailed information about the selected contact.

To switch between the Contact List and Detail views, click  or .

��� ������� 
� 
 ���	
�	

Now that you’re on board, make it official by adding yourself as a contact.

�� Choose Contact/Account from the Insert menu.

�� Click  in the Insert New Contact/Account dialog.

�� In the Insert New Contact dialog, fill in the information about
yourself:

♦ Press TAB to move from field to field.

Be sure to enter
contact and account
information accurately.
This information is
used exactly as you
type it when you send
e-mail, letters, and
faxes. It is also used
when you search for
contact and account
characteristics.
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♦ If the  button appears when you go to a field, you can
click it to select from a pick list, or you can type directly
into the field.

♦ Type your company’s name in the Account field.

♦ Click OK.

�� In the Edit Account Information dialog:

♦ Confirm that the information you entered is correct.

♦ Select <None> as the account type.

♦ Set yourself as the account owner.

♦ Click OK.

The Contact Detail view appears showing the information you entered about
yourself.

Check the information again to make sure it’s accurate and add anything
you’ve left out. It’s better to have too much detail than not enough.

��� ���� �� �		�
���

Owning an account means you can use any account-, contact-, or
opportunity-related feature; for example, scheduling activities, running
reports, attaching processes, and so on. In SalesLogix, the user who adds
an account does not necessarily own it. You can add an account and
assign another user or team of users as the owner. For example, you
might have an assistant that enters new accounts and assigns you as the
owner, or a Telemarketing group that enters new accounts and assigns
ownership to a sales team.

Sometimes it may be necessary to change the owner of an account. Your
department might reorganize, some individuals may be replaced, or
different people in your company might need ownership of an account at
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different stages of the sales cycle. Once an owner is assigned, a set of
rules governs who can change the owner.

Your access to data within an account, contact, or opportunity is
controlled at the table or field level. You can have different data access
rights as an individual owner of an account and as a member of the team
who owns an account. For example, if you own an account as an
individual, you might have full access rights to all tables and fields, but as
a member of a team you have view-only rights.

The Account and Contact Detail views include an Owner field. You set
ownership in the Account Detail view; the Owner field in the Contact
Detail view is for display purposes only. In the Owner Assignment dialog
you can assign an individual user, team of users, or everyone as the
owner.
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Related Help Topics

To learn: Open these topics:

About SalesLogix features Introducing SalesLogix

How to log onto SalesLogix Getting Started

Logging onto SalesLogix

About your SalesLogix
workspace

Getting Started

Your Workspace

How to customize
SalesLogix

Getting Started

Setting Preferences

How to use your calendar Managing Your Daily Tasks

Scheduling Activities and Events

Using Your Calendar

About accounts Accounts

What Are Accounts?

Who Owns an Account?

About contacts Contacts

What Are Contacts?

Adding Contacts

Working with Contact Detail
Information
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Time to get to work. The boss filled you in on “corporate culture” at
lunch, stressed that e-mail is the preferred method of communication to
keep paper to a minimum, and handed you a folder full of notes and memos
(seems old habits die hard). Better skim through the notes and check the
mail.

You were wise to check the paper
first…there’s an important note at the
top of the pile. Back to your calendar
to add to your schedule. But first you
better check your mail to get the
actual dates of the trade show and see
what else you need to schedule.

����� ��	
 �����

SalesLogix provides a seamless
connection to your company’s e-mail
system. The icon in the bottom right corner of your SalesLogix screen tells
you if you’re logged onto e-mail. If the icon looks like this, , you’re
logged on; if it looks like this, , you’re not. To log on, right click the icon
and select Logon to E-Mail from the shortcut menu.

Your e-mail software opens to the compose message screen. Using the
functions of your e-mail system to read your messages, you find lots of
welcomes from your co-workers and complete information about the trade
show next month.

���� ��� ���	
	�	�� �� �
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Activities include making phone calls, going to meetings, and completing
to-do’s, such as sending correspondence or preparing a presentation. An
activity is generally scheduled for a portion of the work day. In contrast,
events usually span several days; for example, a trade show, business trip,
or vacation. You can schedule activities during an event, such as
appointments you make during a business trip. Scheduled activities
appear on your calendar and on the Activities tab in the Activities view.
Scheduled events appear on the Events tab in the Activities view and

If you get an error
message when you log
on, your e-mail options
may not be set
correctly. Contact your
system administrator
for help.
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above the timeline in your calendar.

In addition to business-related activities, you can also schedule personal
activities, which are private obligations, such as a doctor appointment.
Personal activities are not attached to an account, contact, or opportunity.

When you wrap up an activity, it is important that you mark it as
complete so you have a record of it in the contact history. This is obvious
when you finish a meeting or return from an appointment. However, you
also probably complete activities that are not formally scheduled, such as
returning a phone call or answering e-mail. You can record these
unscheduled activities directly into a contact’s history by entering it as a
completed activity.

In some cases you might want to schedule an activity for a specific date,
but not at a specific time. Timeless activities are scheduled to occur on a
certain date, but at no particular time. Timeless activities display in the
timeless section in the Day and Week Calendar views. In the Month and
Year Calendar views, timeless activities display without a scheduled time.

If you have a staff meeting every Monday morning, you can schedule it
as a recurring activity. Recurring activities take place at the same time
each day, week, month, or year.

You can also schedule activities that include other SalesLogix users and
reserve resources for an activity, such as a conference room or overhead
projector. To make sure you are prepared for upcoming activities, you
can set a pre-activity alarm.

You can configure the Activity Manager to alert you to activities that are
overdue or waiting confirmation. If an activity is overdue, you can roll it
over to the next day.

�������� 	 
���

��������

�� From any SalesLogix view, right click and select Schedule from
the shortcut menu.

�� Select Meeting from the cascading menu.

�� In the Choose Activity Date dialog, click next Monday’s date and
click OK.



� � � � � � � � � � 
 � � � � � � 
 �  �

��

�� In the Meeting Regarding dialog, click , type Staff
Meeting into the Item field in the Add List Item dialog, and click
OK. This adds Staff Meeting to the pick list. Select Staff Meeting
from the list and click OK.

�� Click  and in the Specify Time and Duration dialog, position
your cursor at 8:30 and drag to 10:30. This should allow plenty of
time for the meeting as well as following up on action items when
it’s over. Click OK.

�� In the Alarm area of the Schedule dialog, click the Set Alarm
check box and set the alarm for 15 minutes lead time.

�� Click the Recurring tab in the Schedule dialog.

�� Click Weekly to select a frequency for the meeting.

�� Set the Weekly options. Your meeting is every week on Monday.

	
� Click , select next Monday’s date for the first occurrence of the
meeting, and click OK to close the dialog.

		� To schedule the meeting for each Monday for a year, enter 52 in
the End after X occurrences field.

	�� Click OK to display all scheduled occurrences of the activity on
your calendar.

������� 	�
� ��� ���
�

A list of values you can select from when entering data in a field is called
a pick list. Pick lists are useful because they encourage consistent data
entry. You can open a pick list by pressing F2, clicking , or double-
clicking in the field. If the pick list supports selecting multiple items, a
�displays next to the items you select. Your ability to add, edit, or delete
pick list items is determined by your access rights.

�������� 	
 ���
�

Since the trade show spans the better part of a week, you schedule it as an
event rather than an activity.

	� From any SalesLogix view, right click and select Schedule from
the shortcut menu.

�� Choose Event from the cascading menu.

The appearance of the
dialogs in steps 3, 4,
and 5 depend upon
how your scheduling
options are set. If you
do not see these
dialogs, select Options
from the Tools menu
and set the When
Scheduling Prompt For
items on the Activities
tab to On.

You can only delete an
activity or event that
you created.
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�� In the Event Editor dialog, click  in the Start Date field, select
the event starting date, and click OK.

�� Click  in the End Date field, select the event ending date, and
click OK.

�� In the Day Type field, click  and select Trade Show from the
list.

�� For your own information, type a description of the event and click
OK.

��������		
��� ����

����

When you schedule a meeting or phone call in SalesLogix you can include
other SalesLogix users in the activity using the Members tab in the Schedule
dialog. Appointments you schedule this way appear on the Confirmations
tab in the other users’ Activities view. When your manager told you to
check if there were other meetings you needed to attend, she was suggesting
you check the Confirmations tab.

�� Click  on the navigation bar.

�� Click the Confirmations tab in the Activities view.

You find the next two training sessions listed.

�� Select the first session on the Confirmations tab, right click, and
select Confirm Activity from the shortcut menu.

�� In the Confirm/Decline Activity dialog, select Confirm or Decline
from the drop-down list.

�� Enter a response in the Reply memo box.

Be sure to use a
meaningful type of day,
because this is how the
event is identified in
your calendar display. If
the type of day you
want to assign to the
event is not on the list,
you can type directly
into the field.

You can also schedule
an activity on another
user’s calendar. For
example, if you need a
quote for a proposal,
you might schedule it
as a to-do for a co-
worker. To do this,
when you schedule the
activity, select the other
user’s name in the
User field on the
General tab of the
Schedule dialog.
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�� Click OK.

The trainer who scheduled the activity is notified on her
Confirmations tab. If you accept, the activity is scheduled on your
calendar.

�� Repeat the process to confirm the other training session.

Related Help Topics

To learn: Open these topics:

How to use e-mail with
SalesLogix

Managing Your Daily Tasks

Communicating with Contacts

Using E-mail

About your e-mail and
activity options

Getting Started

Setting Preferences

About activities and events Managing Your Daily Tasks

Scheduling Activities and Events

What Are Activities and Events?

Recurring Activities

Scheduling an Event

Activities with Multiple Users

How to work with pick lists System Maintenance

Pick Lists
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That brings your business appointments up to date. You’ll schedule
your personal appointments, too, so you can have a complete picture of
your calendar in a single place.

��
	�  �	����� ���
�


In addition to business-related contacts, you can enter personal contacts into
SalesLogix. For example, you can enter the name of your stockbroker to
make it easy to communicate from work. When you enter a personal
contact, a “dummy” account is created using the contact name (last name,
first name) and your name is automatically inserted in the Owner field.

�� Select Contact/Account from the Insert menu.

�� Click  to add a new personal contact.

�� Enter the contact and account information in the appropriate
dialogs. (For example, you can enter information about your
stockbroker.)

�� Click OK to close the dialog.

�� Enter additional information in the Contact Detail view.

You can find your personal contact in both the Contact and Account List
views.

Speaking of your stockbroker, you should send him a fax with your new
work phone and fax numbers as well as your e-mail address. When you send
faxes or letters to contacts in SalesLogix, you use templates.

���� ��� ���	
�����

Templates are predefined form letters (or memos, or proposals, or any
other document) that consist of static text that does not change, and
merge fields, which SalesLogix fills in using information related to the
current contact. For example, a letter template you use for miscellaneous
correspondence might contain merge fields for the date, contact name,
account name, address, salutation, and your name and title. You would
fill in the content of the letter on an individual basis. Or a template could
be a multi-page proposal, containing the standard proposal text and

The contact’s name is
stored in the database
in a way that allows
SalesLogix to
differentiate the title,
first name, middle
name, last name, and
suffix. To ensure that
the components of the
name are stored
correctly, double-click
the Contact Name field
and type the contact’s
name into the Enter
Name dialog.
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merge fields for relevant information about the contact, account, and
opportunity.

SalesLogix includes basic templates for letters, memos, and fax cover
sheets. You may also find templates customized for your specific needs.
You can build new templates or edit existing templates.

Templates can be Public or Private. Public templates are distributed by
the system administrator and stored in the Public Templates folder.
Templates you create or edit are private and are automatically stored in
your Private Templates folder.

���� � ���

�� Click  on the navigation bar.

�� In the Contact Detail or List view, click .

�� Type the first few letters of the contact’s last name into the Find
text box. The first matching item in the list is highlighted.

�� Continue to scroll through the list until the contact you are looking
for is highlighted.

�� Double-click the contact to open the Detail view.

�� Check that there is a fax number for the contact in the Detail view.

	� Click  on the toolbar.

The default fax template appears in the word processor view with
the merge fields filled in with information about the selected
contact. If you want to use a different template, you must use Mail
Merge. If you do not want to use the template, select New from the
File menu to start with a blank page, or select Open from the File
menu and choose another document. You can open any document
saved as an .rtf file.


� Type additional text into the fax cover page and make any
necessary editing and formatting changes.

�� Click  on the toolbar to see how the document will look when

printed. Click  to return to the document.

If your contact list is
very long, try this to
speed up the search:
Type the first letter of
the contact’s last name

and click . The list
now shows only
contacts whose last
name matches the
letter you typed.

If you have trouble
sending a fax or using
the fax template, your
fax options may be
incorrect. Check with
your system
administrator.
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��� When you are satisfied with the fax, select Save from the File
menu. Type a name for the fax. If you do not change the folder, the
fax is saved in your Private Documents folder. Click Save.

��� Click  on the word processor toolbar to send the fax.

��� Click Yes if you want to record the fax as a completed activity in
the contact’s history. In the Complete FAX dialog, fill in the
information about the fax you are sending and click OK.

��� Click Yes if you want to attach the fax to the contact. Select the
directory where you want to save the document, enter a name (or
use the name you assigned in step 10), and click Save. Documents
you attach to a contact are listed on the Attachments tab in the
Contact Detail view.

��� Select Exit from the File menu to close the word processor. When
you exit the word processor, the fax is sent.

�������� 	 
����	� 	�������

To make sure it doesn’t slip through the cracks, you better add your dentist
appointment to your calendar.

�� From any SalesLogix view, right click and select Schedule from
the shortcut menu.

�� Choose Personal Activity from the cascading menu.

�� In the Select Activity Start Date dialog, click the day you want to
schedule the appointment and click OK.

�� In the Personal Activity Regarding dialog, select Dentist
appointment from the list and click OK.

�� Click  in the Activity Times area and set the duration of the
appointment. (Remember to allow extra time, you always have to
wait for the dentist.)

	� Set an alarm to make sure you leave on time.


� Click OK to close the Schedule dialog.

To see a list of all your personal activities, click  on the navigation bar
and select the Personal tab.

The appearance of the
dialogs in steps 3 and 4
depends upon how
your scheduling options
are set. If you do not
see these dialogs,
select Options from the
Tools menu and set the
When Scheduling
Prompt For items on
the Activities tab to On.
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Related Help Topics

To learn: Open these topics:

How to add or find a contact Contacts

Adding Contacts

Finding a Contact

Send form letters and faxes Managing Your Daily Tasks

Communicating with Contacts

Working with Templates

Sending Faxes

How to schedule a personal
activity

Managing Your Daily Tasks

Scheduling Activities and Events

Schedule an Activity
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Visions of a trade show…four days on your feet, saying the same thing
over and over until your voice is gone. Your reward: a two-inch thick stack
of “leads”(which look a lot like business cards that passers by dropped in
the fish bowl at your booth hoping to win a free t-shirt).

You can erase that vision. This time it’s different. That stack of cards
was delivered to your company’s Telemarketing department. They
contacted each lead, and using a structured script to obtain information,
classified them according to level of interest and the match between their
requirements and your product. In other words, they qualified the leads.
Since your sales team was among those that worked the trade show, you
reap the rewards without wasting time trying to guess which of those
business cards might lead to a sale.

How will you find those leads among the thousands of contacts in the
database? No problem. Telemarketing searched the database for all leads
generated at the trade show that are owned by your team and have a “hot”
status. They saved the lookup as a contact group. All you have to do is find
your leads in the group and get the sales process going.

���� ��� ��	
��

Groups help you manage your workflow. You can use groups to work
with a subset of your accounts, contacts, or opportunities, to select data to
include in reports, and to send mailings, e-mail, and faxes using
SalesLogix Mail Merge. You can create a group based on a specific set
of conditions that you define, or choose individual accounts, contacts, or
opportunities from your database. Any account, contact, or opportunity
can be a member of more than one group.

For example, suppose you want to target specific accounts for a sales
campaign featuring a specific product line. You could build a conditional
statement to look for active accounts that purchased related products
during the past year. Accounts that meet these conditions are placed in a
group you name Promo ’97. You could then use Mail Merge to send
promotional material to the accounts in the group. Groups created based
on a set of conditions are dynamic. Each time you open a group, your
accounts, contacts, or opportunities are re-evaluated using the conditions
you defined.

If you want to create a group whose members are selected based on your
personal knowledge of the account, contact, or opportunity, or where
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there is no clear set of conditions with which to select the correct
accounts, contacts, or opportunities, you can create an Ad Hoc group. For
example, suppose you have 20 tickets to the PGA and want to invite 19
of your contacts. It would be difficult to create a set of conditions that
would select exactly 19 contacts. You can select these unrelated accounts,
contacts, or opportunities from the List view and save the selected items
as a group. Unlike groups based on a conditional statement, Ad Hoc
groups are static; their content always remains as it was when the group
was created.

To view a group, click the Group button in the Account, Contact, or
Opportunity Detail or List views. While a group is active, only the
accounts, contacts, or opportunities that are members of the group
display.

���� �� ���� 	
��

�� Open the Contact List or Detail view.

�� Click the Group button in the upper right corner of the view.

�� If necessary, click  to
open the Contact Groups
list.

�� Double-click the Hot Leads
group.

The Group button changes
to display Hot Leads and
shows the number of leads
in the group. To find your
leads, you need to filter them out of the Hot Leads group. Your
boss told you to look for leads that had “Prospect A” in the Type
field.

�� With the Hot Leads group active, select Type from the Lookup
menu.

�� Type Prospect A into the criteria field in the Lookup Contact
dialog.

	� Check Within Current Group/Lookup (Hot Leads) at the bottom of
the dialog. This limits the search to the current group.
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�� Click OK to initiate the lookup.

�� Now the Group button reads Prospect A and shows the number of
leads you need to pursue. You’ll want to save this list as a group
for future reference.

��� Select Save As Group from the Lookup menu.

��� Type a name and a description for the group and click OK.

��� Click the Group button to see that the new group is now on the list.

����� ���	
�

You just used Lookup to do a very simple search. Before you received
the Hot Leads group, Telemarketing used Lookup for a more complex
search. They located all the leads generated at the trade show with a “hot”
status that are owned by your team. As you can see, Lookup is a powerful
tool.

There are four ways to set up a lookup, ranging from a simple keyword
search to a complex lookup based on criteria you define.

The simplest and fastest way to look up accounts, contacts, or
opportunities is to use the predefined lookups such as company, first
name, last name, city, state, and so on, that are included on the Lookup
menu. You can also do this kind of search by clicking a field name in the
Detail view. This opens the Lookup dialog where you can further define
the criteria for the search. Using the result of the first lookup you can
continue to filter the list by doing additional lookups. For example, you
could look up all the accounts that are not in the United States, and then
filter that group according to sales rep.

Use the Keyword Search lookup to build a list of accounts, contacts, or
opportunities by searching the database using a word you enter. You can
specify the fields and tables SalesLogix searches. For example, you
remember entering a note reminding you of a contact’s vacation. You
can’t remember where you entered the note or the name of the contact, so
you use the keyword lookup to search for the word “vacation.”

To search several fields simultaneously, you can use a query by example
lookup. In this type of lookup, you enter information into several fields of
the Detail view. The lookup produces a list of accounts, contacts, or
opportunities that contain matching information. For example, you could
search for accounts in Ohio with a specific SIC code and credit rating.

The most complex type of lookup is based on a specific set of conditional
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statements that you define in Query Builder. Using Query Builder you
can simultaneously search multiple fields in the database using conditions
such as AND and OR. For example, you could search for all active
accounts with revenues over $100,000 in the last six months that are
owned by either the Gold or Silver sales teams.

����� ���	
��� ���

When you build a group, follow these guidelines:

♦ If the group selection conditions are complex, you can use
several consecutive lookups to identify the accounts,
contacts, or opportunities for a group. Use the broadest
conditions for the first lookup. In each successive lookup,
add conditions to narrow the list of selected records. Once
your list represents the correct records, select Save As
Group from the View menu to save the group.

♦ If you are building an Ad Hoc group, use Lookup to
narrow the list of prospective group members, then select
specific records and save the group.

♦ If you use a lot of groups, be sure to enter meaningful
group names and descriptions so you know why you
formed the group.

♦ If many users need access to the same groups, create one
group and use SalesLogix Architect to release the group to
the appropriate users.
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Related Help Topics

To learn: Open these topics:

How to create contact
groups

Contacts

Grouping Contacts

How to find a contact Contacts

Finding a Contact

How to use mail merge Managing Your Daily Tasks

Communicating with Contacts

Corresponding with a Group of
Contacts

How to use lookup Contacts

Finding a Contact
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Now you have your very own group of hot leads to work with. You
need to contact all the prospects quickly—before “hot” turns cold and you
have to start from scratch. You can easily send an introductory letter with
literature about your product to every prospect in the group. At the same
time, you can schedule a follow up phone call.

����� � �	
�� ������

In the “Getting personal…” section of this guide you learned how to use a
template to send a fax. To create a cover letter for the literature you’re
sending to the prospect group, you’ll create a new template by editing an
existing template.

�� Select Templates from the Write menu.

�� If necessary, click  to open the Private Templates list. Click 
again to open the Letter folder.

�� Select the letter you want to use as the base letter for the new

template and click .

The template opens in the word processor window. As shown
here, the template contains merge fields and static text.
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�� Edit the template.

♦ Check the merge fields to make sure they will contain the
correct information. For example, you want to be sure the
date is included, that the contact’s first and last name will
be in the correct order, and that all the elements of the
address are included. When you select this template as
the cover page for the literature pack, SalesLogix creates
a letter for each member of the group and fills in the
merge fields with information about the contact.

♦ Add the text you want to include in the cover letter—
introduce yourself, explain why you sent the letter, and
draw attention to the literature it contains. Invite the
prospect to call you or include the approximate time
when you will be getting in touch. (You’re sending
exactly the same letter to every prospect, so you want to
give yourself a span of time to make all the calls.)

♦ If you want to change the appearance of the letter, use the
items on the Format menu to define the page layout,
paragraph spacing and indents, and text styles, fonts, and
alignment.

�� To see how the page layout looks, click the  on the toolbar.
Check the page layout, close the Print Preview window, and adjust
the elements of the template as necessary.

�� When you are satisfied with the template, select Save As from the
File menu and enter a new name for the edited template in the
Properties dialog. Click OK.

�� Click  to close the word processor.
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Your cover letter is complete, so you can schedule the literature request.

�� Select Literature Request from the Schedule menu.

�� Enter the reason for the request in the Description text box.

�� Enter the date you want to
have the literature sent by.
The default is five days
from today, but since you
want to make contact
quickly, you change the
date to three days from
today (and hope the
assistant who fills the
requests can do it).

�� Click  and select a
shipping method from the list. E-mail would be the fastest method,
but since you’re sending printed material, it’s not appropriate.
Click OK.

�� Click  in the Cover field and choose the template you just
created from the list.

�� Select the Specific Group button, click , and select the prospect
group you created from the list.

	� Specify the materials to be included in the package. Select a title
from the list and click the up and down arrows to the right to set
the quantity for each item. Continue to select items and set
quantities. When the cover letter is printed, the items you select are
included in a list of attachments.


� Click OK. The literature request is recorded on the Literature and
All Open tabs in the Activities view and on the Activities tab in the
Contact Detail view.

The assistant assigned to monitor Literature Requests will fulfill your
request by the date you specified. If you want to check the status of your
request, click the Activities tab in the Detail view for one of the contacts in
the group. If the request has not been fulfilled, it is still listed. Once it has
been fulfilled, it appears on the contact Notes/History tab.

If you have the
appropriate access
rights, you can add or
delete materials from
the literature list.
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The last step is to schedule a follow up phone call for each contact in the
group.

�� Click  on the navigation bar.

�� If you are in the Contact Detail view, switch to the List view by

clicking  on the toolbar.

�� Make sure your prospect group is active. If not, click the Group
button and choose the group from the list.

�� Select the first prospect name on the list, right click, select
Schedule from the shortcut menu, and select Phone Call from the
cascading menu.

�� In the Select Activity Start Date dialog, double-click the date when
you want to schedule the phone call.

�� Double-click Confirm Literature Received in the Phone Call
Regarding dialog.

By default, phone calls are scheduled as timeless activities—they
are scheduled for a particular day, but at no particular time. Since
you are going to call many prospects over a few days, you want to
make sure you allocate a specific time to make the calls.

	� Click  in the Time field. Drag down the timeline to block out
the time when you want to schedule the phone call. Click OK.


� In the Schedule Phone Call dialog, click OK to schedule the phone
call.

�� Move to each name on the contact list and schedule a phone call
for each prospect in the group.

The appearance of the
dialogs in steps 5 and 6
depend upon how your
scheduling options are
set. If you do not see
these dialogs, select
Options from the Tools
menu and set the
When Scheduling
Prompt For items on
the Activities tab to On.
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You know how easy it is for a phone call to “fall through a crack.” To make
sure you don’t let these calls slide, you can set the Activity Manager to alert
you to calls you didn’t complete.

�� Select Options from the Tools menu.

�� Click the Activities tab.

�� Click the Phone Calls button.

�� In the General Settings area, make sure Rollover on startup is
checked.

�� Click OK to close the Options dialog.

If you fail to complete a phone call on the day it is scheduled, the Activity
Manager will remind you when you start SalesLogix the next day.

Related Help Topics

To learn: Open these topics:

How to create or edit a
template

Managing Your Daily Tasks

Communicating with Contacts

Working with Templates

How to send a literature
pack

Managing Your Daily Tasks

Communicating with Contacts

Sending Literature to Contacts

About adding literature to
the list

System Maintenance

Literature

How to schedule a phone
call

Managing Your Daily Tasks

Scheduling Activities and Events

Scheduling an Activity

How to set up the
Activity Manager

Getting Started

Setting Preferences

While you are on the
Activities tab, you can
also change the When
Scheduling Prompt For
options and the Default
Alarm Settings for each
type of activity.
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Your database is chock full of information about contacts and accounts
and opportunities. Rather than running blind when you call the prospects,
you decide to jump into the fray armed with as much information as
possible by reviewing the contact notes and history and running some
reports.

������� 	�
� ��
� ��� ��
���

You can review all interactions with an account, contact, or opportunity
by looking at the Notes/History tab in the Account, Contact, or
Opportunity Detail view. This tab displays a list of notes and past
interactions with the account, contact, or opportunity, including
correspondence, completed activities, literature requests, and processes.
The tab shows the type of activity, its date and time, the user who entered
the item, a brief description of the item, and the result. Notes about the
item are included as well as its category.

���� �����	
 �� � ���� � ��� ����
���
���� ���

To see a snapshot of the information recorded about an item, just pause the
cursor over the item. A Tool Tip pops up with basic information about the
activity or note. For a more detailed look at the item:

�� Select a contact, account, or opportunity.

�� In the Detail view, click the Notes/History tab.

�� Double-click an item in the grid.

If the item is a note, the View Note dialog opens. If the item is a
completed activity, the View Completed Activity dialog opens.

�� Review the information and click .

You can only edit or
delete notes and
history items you
created.
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If something catches your attention as you review the notes entered by
Telemarketing during their initial qualification, you may want to add a note
so you don’t lose the thought.

�� Select the contact you want to add the note to.

�� In the Contact Detail view, select  from the toolbar.

�� Fill in the fields in the Create Note dialog and click OK. The Note
is recorded on the Notes/History tab.

������� 	�
� ����
�

In addition to information directly related to the prospects, you can run
reports to view and analyze data about your accounts, contacts, and
opportunities. SalesLogix includes a variety of reports that range from
basic address and activity listings to analysis of opportunities by
probability of close or sales potential. You may find additional reports
that have been customized for your company or department. When you
run a report you can set filters to limit the dates covered by the report or
the specific accounts included in the report. After you run a report, you
can print, fax, e-mail, or save it.

	
� � ������

When you start calling the prospects, your goal is to set up meetings as soon
as possible. If you know which prospects are located close to each other,
you can set up your schedule to minimize travel time. Running a report
showing the prospects’ locations sorted by zip code will help you do this.

�� Open the Reports view by clicking  on the navigation bar.

�� In the tree view, click  next to Contacts to expand the list of
Contact reports.

�� Select the Contact Address Book - (Your Name) report.

�� In the Filter by Contact area, click the Specific Group button and
select the Prospect A group from the drop-down list.

�� Click  to sort the addresses by zip code. Sorting
changes you make are temporary; after you print, fax, e-mail, or
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save the report to a file, the report reverts to the default filters and
sorts.

�� In the Query Builder dialog, click the Sorting tab. Notice that the
default for this report is to sort by the contact’s last name.

�� Click  next to the ADDRESSID field at the top of the dialog to
see the fields that make up
the contact’s address.

�� Drag the POSTALCODE
field to the Sorting tab.

�� Click  to delete
the Contact.Lastname sort
and click OK.

��� Click  to see how
the report will look.

��� In the Report Preview view, click  to make the report legible on
your screen. Note that the contacts are sorted by zip code. Click

 to close the preview.

�	� Click  to save the report. In the Save Report to a File dialog,
open the folder in which you want to save the report, name the

report, and click .

�
� Click  to print the report.

Related Help Topics

To learn: Open these topics:

How to work with notes and
history

Contacts

Notes and History

About reports Reporting

Working with Reports

Running Reports
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It’s the first day of the scheduled phone calls to the prospects. You have
10 calls scheduled and anticipate leaving five messages with assistants and
five on voice mail. You have your message speech prepared. You dial the
first prospect and hope for the best. It must be your lucky day—you get
through to the first prospect on the very first try. (Maybe it really is a good
idea to call before 9 a.m.) You’re on a roll—the prospect was impressed
with your letter and literature and is interested in hearing more. You
schedule a meeting for next week and update your records.

�������� 	 �
��� �	��

�� On your calendar, select the phone call you just completed.

�� Right click and select Complete Activity from the shortcut menu.

�� Fill in the Complete Phone Call dialog. The information in the
dialog reflects what you entered when you scheduled the activity.
You can change the information as necessary.

♦ Set the completed
date and time. You
completed the phone
call right on
schedule, so no
change is required.

♦ You completed the
phone call, so you
don’t need to change
the Result field.

♦ Since you are going
to follow up with a
meeting, in the Schedule a Follow-Up area, select
Meeting from the Type list. Check Carry Over Notes if
you want the notes from your phone call copied to the
meeting activity.

�� The information in the Regarding field is correct, so there’s no
need to change it.

�� Select a Category from the list. Leads might be the appropriate
choice.
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�� The Contact and Account are correct, so you do not need to
change them. It’s a little early to enter an opportunity for this
contact, so you can leave that field blank.

�� Enter notes about the phone call that will be useful in your
interactions with the prospect—specific items the prospect
mentioned or the fact that you reached him directly at 8:15 in the
morning.

�� Click OK.

���� ���	�
�	 �� �������	��

Since you indicated a meeting would follow the phone call, when you click
OK to complete the phone call, the Schedule dialog opens so you can
schedule the meeting. In the same way you scheduled the phone calls:

�� Select the date you agreed on with the prospect.

�� Set the time by dragging on the timeline. Be sure to allow enough
time to get to the prospect’s office and return to your office (or to
your next appointment).

�� Change the alarm settings if you want a reminder before the
meeting.

	� Fill in the rest of the Schedule dialog, click OK, and get back to
calling the rest of the prospects.

Related Help Topics

To learn: Open these topics:

How to complete an activity
and schedule a follow-up
activity

Managing your Daily Tasks

Scheduling Activities and
Events

Complete a Scheduled Activity
or Event
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You need to get presentation materials together before your
appointment. Fortunately, you don’t have to build a presentation yourself.
You find the perfect presentation in the Sales Library and customize it for
the prospect.

���� �� ��� 	�
�� ������

The Sales Library is a central repository for company information. Files
are organized into categories by creating folders and attaching files to the
folders. Your company’s library might include product information,
presentations, policies and procedures, sales literature, spreadsheets,
news bulletins, price sheets, annual reports, and manuals.

Only the administrator can add files to the Sales Library. If you are a
workgroup user, you can access a file directly from the Sales Library
without storing the file on your workstation. If you are a remote user, you
can request files from the Sales Library.

��� � �����	���
�	 ��� ��� ����� �
�����

�� Click  on the navigation bar.

�� Click the folder that contains the presentation you want to open.

�� Double-click the file icon to open the file.

�� Copy the presentation to your computer so you don’t change the
master version as you customize it. Make your changes and print
your slides.

You’re ready for the appointment.

Related Help Topics

To learn: Open these topics:

About the Sales Library and
how to open files

Sales Library

Working with the Sales Library

Opening or Ordering a File
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 You meet with the prospect and his associates, demonstrate your
product, dazzle them with your presentation, and collect their requirements.
They tell you to submit a proposal ASAP. You commit to getting the
proposal to them in three days and schedule a follow-up meeting for next
week.

�������� �	�����
�� ��
�
�� �� �����  ���������
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You’re back in the office. Before your glow of success fades, complete the
meeting activity and schedule the follow-up appointment (just as you
completed the phone call and scheduled the first meeting). Make sure you
check Carry Over Notes so you can keep a running narrative of your
activities with this prospect. Be sure to record “color commentary” along the
way. Knowing if a contact plays golf or sails may come in handy down the
road.

Related Help Topics

To learn: Open these topics:

How to complete a
meeting activity and
schedule a follow-up
activity

Managing your Daily Tasks

Scheduling Activities and Events

Complete a Scheduled Activity or
Event
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You’ve got the prospect’s requirements and a good idea of what this
deal may reap if you can close it. There’s a good opportunity for a sale
here. You should enter the opportunity into SalesLogix so you can track its
progress.

���� ��� �		���
������

You use the SalesLogix Opportunity views to collect and analyze
information relating to your potential sales to accounts and contacts. The
Opportunity Detail view contains a variety of fields for you to record
detailed information about each opportunity. It’s not necessary to fill in
all these items; when you add an opportunity, enter the information that is
most important to your organization and add additional items later. To
start, you might want to enter only the probability of closing the sale, the
dollar amount, and the estimated close date. As the sale develops, you
can track any combination of the following information:

♦ probability of close and potential revenue
♦ days in the pipeline
♦ estimated and actual close dates
♦ cycle and stage
♦ products involved in the sale
♦ competitors
♦ lead source
♦ related activities
♦ each key contact’s involvement and influence over the

opportunity

To follow the progress of a potential sale, analyze the effectiveness of
your sales process, project revenues, and so on, you can generate a
variety of forecasting and opportunity reports.

You can work with your opportunities in a table format in the
Opportunity List view or see in-depth information about a single
opportunity in the Opportunity Detail view. To manage your workflow,
you can group opportunities using Lookup to search for opportunities that
satisfy specific criteria.
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�� Click  on the toolbar.

�� In the Insert New Opportunity dialog, type the name of the new
opportunity.

�� Click  in the Account field to select the account associated with
the opportunity.

�� Click  in the Lead Information area and select the lead source.

�� Select a status from the list. If the status you want to enter is not
included on the list, you can type in the field.

�� Click OK.

	� In the Select Products dialog, click a product and then click

 to fill in information about the price and quantity.
SalesLogix computes the forecast based on the information you
enter. Click OK. Select additional products if appropriate. Click

 to move to the next dialog.


� In the Select Competitors dialog, click a product and then click

 to indicate if the competitor is the incumbent. Click

OK. Select additional competitors if appropriate. Click 
to move to the next dialog.

�� In the Select Contacts dialog, click a contact and then click

 to specify the contact’s influence on the opportunity.
Enter any issues related to working with this contact. Click OK.

Select additional competitors if appropriate. Click  to
move to the next dialog and click OK.

All the information you entered appears in the Opportunity Detail view. You
can edit the information or add details at any time.

The dialogs you see
when you enter an
opportunity may appear
in a different order than
the dialogs in these
steps. To set the order
in which the screens
appear when you add
opportunities, select
Options from the Tools
menu and click the
System tab. Set your
preferences in the
Opportunity Wizard
area.

If you have the
appropriate access
rights, you can edit the
products and
competitors lists. Select
Manage from the Tools
menu and then select
Products or
Competitors from the
cascading menu.
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Whenever you add an opportunity or a contact, be sure to record the
source of the initial lead; for example, a trade show, magazine ad, word
of mouth, direct mail, and so on. If you keep careful track of your lead
sources, you’ll be able to calculate the cost of each lead, the percentage of
leads from a particular source that develop into sales, and so on. For
contacts, lead sources are listed on the Lead Sources tab in the Contact
Detail view. Lead sources associated with opportunities are found on the
Opportunity Detail view.

��������� � 
��� ����� ���� �� ����������

�� Click  on the navigation bar to open the Opportunity Detail
view.

�� Select an opportunity.

�� Click  to the right of the Lead Source field.

�� Select a lead source from the list.

�� Click OK.

Related Help Topics

To learn: Open these topics:

About opportunities and how to
add them

Opportunities

What Are Opportunities?

Adding an Opportunity

If you have the
appropriate access
rights, you can add,
edit, and delete items
from the list of available
lead sources.
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You committed to delivering the proposal within three days.
Fortunately, you don’t have to start from scratch. You can use a proposal
you already prepared as the base and just customize the products and
pricing for this prospect. You do need to get the pricing information from a
co-worker, so you better get started. Unfortunately, you can’t remember the
name of the contact or account involved with the earlier proposal, but you
do remember that you referenced it as “my first proposal” in the contact’s
notes.

����� � ��	�	
��

Since you know there is a reference to the “base” proposal in the contact’s
notes, you can use a Keyword Search lookup to find it.

�� Select Other from the Lookup menu and select Keyword Search
from the cascading menu.

�� In the Keyword Search dialog, type “my first proposal” in the text
field and check the Notes/History option (since that’s where you
entered the reference to the proposal). Click OK.

SalesLogix displays the relevant contact in the Contact List view.

�� Click  on the toolbar and click the Attachments tab.

�� Double-click the attached proposal to open it.

�� Edit the proposal in the word processor, changing the contact
information and content as necessary. Leave the pricing
information blank so the marketing manager can fill it in.

�� Select Save As from the File menu and save the revised proposal
under a new name. Close the word processor.

����� ��� ��	�	
�� �	 ��� 	���� ��	��

�� Open the prospect’s Contact Detail view.

�� Select the Attachments tab, right click, and select Insert
Attachment from the shortcut menu.

�� In the Add Attachment for dialog, click  and find the revised

proposal file. Click .

If the Attachments tab
is not visible, right click
any tab and select
Attachments from the
shortcut menu. You
can use this method to
display or hide any tab
in the Detail views.
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�� Type a description of the file and click OK.

The proposal is now listed on the prospect’s Attachments tab. Now all you
need is the pricing information and the proposal is complete.

���� ����	
 �� � ��������

�� If you are not logged onto e-mail, right click  and log on. If you
are logged on, just click .

�� Compose mail to the marketing manager, giving an overview of
what you need, when you need it, and referencing the contact
name and proposal file.

�� Send the mail.

Since the marketing manager has access to your account information, she
can find the contact, open the attachment, insert the correct pricing
information, and re-save the file. There’s no need to send the entire
proposal. She’ll send you a note letting you know it’s done.

����	
 ��� �������
 �� ��� �������

Since you’re working in such a short timeframe, you’ll e-mail the proposal
to the prospect and follow up with a phone call.

�� Open the prospect’s Contact Detail view and make sure an e-mail
address is entered.

�� Click . Your compose e-mail window opens with the
prospect’s address already entered.

�� Type a cover note for the proposal.

�� Using the features of your e-mail system, attach the document and
send the mail.

�� Schedule a follow-up phone call for tomorrow morning to confirm
that the mail arrived.
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Related Help Topics

To learn: Open these topics:

How to do a Keyword Search
lookup

Contacts

Finding a Contact

How to attach a document to a
contact record

Contacts

Attaching Documents

How to use e-mail Managing Your Daily Tasks

Communicating with Contacts

Using E-mail
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Congratulations! Your proposal was accepted and the prospect placed
an order. (Now your prospect is a customer!) Good for you. You hit that
prospect at exactly the right time. If only it was always so easy...

�������� �	� �	�
� ���� �
 ��	���� � ������ ��

�� Open the customer’s Contact Detail view.

�� On the Activity tab, right click the phone call you just completed,
and select Complete Activity from the shortcut menu.

�� Fill in the Complete Phone Call dialog the same way you did
before. Be sure to schedule a follow-up phone call to check in with
the customer shortly after the order is filled and to update your
notes.

�� Click OK.

����� �	� �������
���

�� Open the customer’s Contact Detail view.

�� On the Opportunities tab, double-click the opportunity detailing
the sale you just closed.

�� In the Opportunity Detail view, click in the Status field and choose
Closed - Won from the list. Click OK.

�� Update other opportunity information as necessary.

Related Help Topics

To learn: Open these topics:

How to complete a phone call Managing Your Daily Tasks

Scheduling Activities and Events

Complete a Scheduled Activity or
Event

How to close an opportunity Opportunities

Edit an Opportunity



� � � � � � � � � � 
 � � � � � � 
 �  �

��

“This is page 43, the place where, if
I don’t take too long doing it, I just
might persuade you to give
SalesLogix a shot.”

“Look, we both know that sales is about selling, not
about mastering some fancy sales automation
technology. But sales automation is happening
everywhere and if it’s going to happen to you, wouldn’t it
be nice if it happened with software that was designed
with you in mind?”

“Yeah, I thought so. So here goes, quick and dirty, by
the numbers.

(1) SalesLogix wasn’t designed by a bunch of technoid
geeks who think sales are things that go with

boats. It was designed by  salespeople for
salespeople.

(2) It’s as simple to use as a contact manager (I oughta know), yet it gives you plenty of
sales-specific features to help you sell more (like the ability to track your deals through
the pipeline).

(3) It’s packed with time-saving shortcuts, like navigation buttons, pop-up lists, and
customizable toolbars to help you do maximum work with minimum typing.

(4) If you’re an ACT! user, you’re going to feel right at home, right off the bat, with menus
and keystrokes that are conveniently compatible.

(5) You can import data automatically–and not just from ACT! but from GoldMine™ and
other products, too.

(6) When you need information RIGHT NOW, pay a visit to the on-line Sales Library, a
great place for price lists, product information and more.

(7) No matter how many gazillion people or departments you’re dealing with at an account,
you’ll always know where you stand, because SalesLogix gives you a company-wide view
of your relationship.

(8) If you aren’t on time and in touch, you’ll have only yourself to blame, because SalesLogix
gives you all the tools you need, including a calendar, word processor, and links to your
fax and e-mail programs.

(9) What about those annoying forecast reports your boss is always asking for? No problem.
SalesLogix can create and communicate them for you automatically.

(10) SalesLogix even does work for you!  Yup. You actually can automate those
routine, monotonous tasks like literature fulfillment, correspondence generation, and
e-mail and use SalesLogix to track the status of each routine, monotonous task.”

Pat

Pat Sullivan is president and CEO of
SalesLogix Corp.

Before launching SalesLogix, Pat was co-
founder and CEO of Contact Software

International,
the original developer/marketer of ACT!
and creator of the contact management

category.
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You’ve been going at full speed since you started this job. Fortunately,
you’ve been diligent about entering information into SalesLogix, so you
should have an accurate picture of what you’ve done and what’s coming
up. This might be a good time to find out what’s still on your plate. But you
don’t want to “page” through every day of your calendar….

���� �� ��� ��	
 ����	��� ���������� ��� ������

You can use the Activities view to manage all your scheduled activities and

events. To open the Activities view, click the  on the navigation bar.
The All Open tab shows a complete list of all your open activities. Each of
the other tabs is devoted to a particular type of activity, event, or other
SalesLogix feature. Double-click an activity to see details about it.

To make the list displayed on each tab manageable, you can select the
timeframe for the displayed items. For example, if the timeframe is Next
Month, only activities scheduled for next month are visible. To select a
different timeframe, right click, select Time Frame from the shortcut menu,
and choose an option. If you have a lot of recurring activities on your
calendar, this feature is especially useful.

The first column in the grid on each tab may contain one of the following
symbols. More than one symbol can apply to a single task. If more than one
symbol is valid, the table indicates the display priority.

Symbol Purpose
Display
Priority

Alarm is active for the activity 1

Activity rollover option is active 2

Recurring activity 3

Task was initiated by a process 4

Process task is complete N/A

Event N/A
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The second column in the grid indicates the type of task.

Meeting Question

Phone call Dialog

To-Do ESP

Note Data Base Change

Page Report

Document Sub-process

E-mail Literature Request

Fax

Additional columns contain information relevant to the tab topic. You can
customize the appearance of the tabs and the columns within the grids on the
tab.

♦ The All Open tab displays ALL the activities you have
scheduled within the chosen timeframe. Double-click an
activity to view detailed information.

♦ The Calls tab lists phone calls scheduled within the chosen
timeframe.

♦ The Meetings tab lists meetings scheduled within the chosen
timeframe.

♦ The To-Dos tab lists to do items scheduled within the chosen
timeframe.

♦ The Personal tab displays all the personal activities you have
scheduled within the selected timeframe. For example, the
dentist appointment you scheduled appears here.

♦ The Alarms tab lists activities that have a pre-activity alarm
set. You can automatically set an alarm for any scheduled
activity by setting selecting Options from the Tools menu,
clicking the Activities tab, and setting the Alarm options.
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♦ The Events tab lists events scheduled within the selected
timeframe.

♦ The Literature  tab lists literature requests you have
scheduled. Literature includes catalogs, brochures,
advertisements, and so on. If the first column on the tab
displays a red box, it means the literature request has been
fulfilled.

♦ The Confirmations tab appears only when another user
schedules you to participate in a meeting or phone call. You
can accept or decline activities listed on the Confirmations
tab.

��� ���� ��	
�� ������ �� ��� ��� ������	
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Suppose you were responsible for following up 50 qualified leads in
your territory. How could you possibly handle that kind of volume, keep
track of what you’re doing, and service your existing customers at the same
time? Don’t worry, you can do it. SalesLogix processes keep you on track.

���� �� � �	
����

A process is a series of tasks that are executed in a specific sequence over
a set time period. You attach processes to contacts (or a group of
contacts). You can use processes to:

♦ Perform repetitive tasks. Remember earlier in this guide, when you
spent a lot of time scheduling phone calls individually to pursue a
whole bunch of leads? You did it the hard way. A process is the easy
way. You could set up a process to schedule a phone call one week
from the current date. Anytime you want to call a contact back in a
week, you schedule this process to automatically place a phone call
on your calendar. Scheduling the process is easier than scheduling
the phone call.

♦ Implement a sales process. You could set up a process that guides
you through qualifying a lead. When you receive a new lead you
would schedule the process, which immediately sends a literature
pack and schedules a follow up phone call in a week. (Sound
familiar?) When you complete the phone call, the process prompts
you to evaluate the prospect’s interest level and decide whether to
schedule another phone call, schedule a meeting, send a letter, or
change the status of the lead.

♦ Provide an automated way of following up with customers. If you
are focused on potential sales and don’t have time to regularly call
customers who purchased from you in the past, you can schedule a
process that sends a letter every 30 days. Letters can urge the
customers to keep you in mind when they make their next purchase
or announce new products and upcoming sales. If you add an
opportunity for the customer, the letter series stops.
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When you use processes, you can:

♦ Schedule a process for yourself or another user.
♦ Attach a process to a single contact or a group of contacts.
♦ View any process attached to a contact to which you have access

rights.
♦ Only scan processes that you attached to a contact.
♦ Only use processes that are released to you. Processes are

released to users in SalesLogix Architect.

��� � ����	

 ����


You probably won’t need to create processes; they will be supplied by your
manager or the system administrator. But to use processes successfully, you
should understand how they work. The following steps demonstrate how a
lead qualification process might work.

�� You attach the Qualify Lead process to a group of target leads.
Since you are sure you can convert some of these to viable
prospects, you set up 5 groups to accommodate different Status
classifications:

♦ Hot

♦ Could be hot

♦ Not so hot

♦ Warm

♦ Cold

Every new lead starts with a Status of (4) Warm.

�� To shake out “hot prospects,” the process sends a letter inviting the
contact to call you or return a card asking for more information.

♦ If the contact calls, the current process terminates and a
new process starts.

♦ If the contact requests information, the process schedules
a literature request. (This is the branch that is followed
here.)

♦ If there is no response in 20 days, the process sends a
follow up letter.
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�� The process schedules a literature request with a prepared cover
letter. The letter thanks the contact for responding, asks her to
review the enclosed literature, and commits you to calling in 7 to
10 days.

At the same time, the process schedules a phone call for you to
follow up with the prospect in 7 days.

�� You make the phone call on schedule, determine the contact’s
interest level, and ask to schedule a meeting for further discussion.

While you are on the phone, the process opens a dialog asking if
you want to schedule a meeting, schedule a phone call, send more
information, or attach a sleep process.

♦ If the contact is amenable, you choose to schedule a
meeting. The Schedule dialog opens so you can enter the
details.

♦ If the contact requests a call back, choose to schedule a
phone call. The Schedule dialog opens so you can enter
the details.

♦ If the contact wants more information, select the third
option. Another literature pack is sent with different
material.

♦ If the contact is definitely not interested, attach a sleep
process. The sleep process wakes up in 30 days and
sends the contact a letter.

�� If the option you select in step 4 causes a change in the contact’s
Status, the process makes the change. For example, if you select
meeting, the Status changes to 2 (could be hot); if you select phone
call, it changes to 3 (not so hot); if you send more information, it
stays the same; and if you attach the sleep process, it changes to 5
(cold). When the sleep process sends the letter in 30 days, the
Status will change back to 4.

Since you set up the groups based on Status, when the process
updates the Status, the contacts are placed in the appropriate
groups. This makes it easy for you to focus on the activities related
to the groups with the most potential.

������ � ��	�
�� �	 � ��	�

�� Click  on the toolbar.
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�� Select a process from the Run Process tree view. Click  if
necessary to expand the list of processes. In this example, you
would select the Qualify Lead process.

�� In the Start this process on area, click the Specific Group button
and choose the Warm Leads group from the list.

�� Make sure your name appears in the Schedule for field.

�� To limit the tasks scheduled for a single day, click the Only
schedule XX processes per day check box and type 8 into the text
box. When the process exceeds this limit, remaining tasks are
scheduled the next day and so on.

�� Click  to see a graphic display of the selected process.
This will help you understand the tasks the process will execute
and where you will need to make a decision about the next step.

�� Click  to attach the process.

You can view processes attached to a contact in the Processes tab or the
Process Manager.

���� ���� ���	�
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To keep track of processes you attach to contacts, you use the Scan options.
Selecting a Scan option starts the process engine, which scans a process to
determine if the next task in the process path is ready for execution. If the
task is ready for execution, the process engine executes it. When the process
engine encounters a task that is not ready for execution, it stops. It’s a good
idea to scan your processes after you attach a new process to make sure it is
running. Within a short time you’ll probably have many different processes
attached to your contacts. Scan your processes at least once a day to make
sure they are not stalled.

	� With the Contact Detail view open, click the Processes tab.

�� Click  to expand the list of processes in each category.

�� Select a process from either the tree view or the grid.

�� Right click and select Scan All Processes from the shortcut menu.

The Run Process tree
view displays the
contact processes to
which you have access
rights. Access to a
process is controlled in
SalesLogix Architect.

You can set options to
run the Process
Manager automatically.
Select Options from the
Tools menu and click
the System tab. Click
the Run Process
Manager on Startup
check box to scan your
processes when you
start SalesLogix. To
scan more frequently,
click the Scan
processes every XX
minutes check box, and
type an interval in the
text box.
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When you run a process, you’ll want to know what to expect as each task
executes. You can look at a graphical map of all the tasks in a process or see
a list of information about when each task is scheduled and completed.

�� Click the Processes tab in the Contact Detail view.

�� Click  to expand the list of processes in each category until you
find the one you want to view, or click a process in the grid.

�� Right click and select Show Graphical View or Show Detail View
from the shortcut menu. The grid on the tab is replaced by the view
you selected.

The graphical view of a process is shown below.

�
���� 	
� �	�	�� �� � ������

Sometimes, while a process is running, you may want to stop it or cancel it.
Once you abort a process you cannot restart it, so be cautious when you
change status.

�� Click the Processes tab in the Contact Detail view.

�� Click  to expand the list of processes in each category until you
find the one you want to change, or click a process in the grid.

�� Right click and select Change Status from the shortcut menu.

�� Select Suspend or Abort.

Use Purge Processes
to delete processes
you no longer need.
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Related Help Topics

To learn: Open these topics:

About processes Managing Your Daily Tasks

Automating Your Tasks

Processes

What Is a Process?

Scheduling a Process

Scanning a Process
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Slow down for a minute. You’re spending all your time working these
new leads. Who’s keeping your current customers happy? Just as you
appreciate it when a waiter delivers your meal and then checks back to
make sure everything’s okay, your customers will appreciate it if you don’t
abandon them after you close a sale. And they just might show their
appreciation by investing in more of your product or service. The message
here—stay in touch!

You’ve seen how SalesLogix processes facilitate lead qualification.
You can also use processes to “touch” your customers often. Processes can
send letters, e-mail, literature, and faxes, and schedule phone calls,
meetings, and to-do’s.

Before you can attach a “Touch the Customer” process, you need to
get your customers together in a group. To do this, you’ll need to find your
active contacts who have made a purchase this year.

��� ����� 	�
���� � ����� � �����

You create this group in two steps: first, you lookup all your contacts, and
then you weed out the active customers who have purchased this year. Since
the second lookup has several “nonstandard” criteria (nonstandard meaning
they don’t appear on the Lookup menu), you’ll need to use Query Builder to
define the lookup. Just follow along and you’ll get the hang of it.

�� Select Owner from the Lookup menu. In the Lookup Contacts -
Owner dialog, your name should be highlighted in the names list.
Click OK.

�� To save the group that resulted from the lookup, select Save As
Group from the Lookup menu. The Query Builder dialog opens,
showing database tables and the fields they contain at the top and a
series of tabs at the bottom.

The first step is to name and describe the group.
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�� On the Properties tab:

♦ The name of the group reflects the name of the Owner
lookup. Type a new name that indicates the ultimate goal
of the lookup—perhaps “Stay in Touch.” The name you
enter here is displayed on the Group button, in the List
view group list, and in the Group Manager tree view.

♦ Enter a description of the group; for example, “active
customers who purchased since January 1.”

The next step is to build the conditional statements by dragging
database fields onto the Conditions tab. Each field begins a
conditional statement. In the Assign Condition dialog, you select a
condition and enter a value for each field. You use the And/Or
connector to combine several statements in a query. Query
Builder uses the condition and the connector in each statement to
determine how to apply the query.

�� Click the Conditions tab. Since you created a group using Lookup,
the query used for the lookup is already inserted in the Conditions
tab.

�� The first conditional statement will determine if the contact’s status
is active.

♦ Scroll through the tree view until you see the STATUS
field and double-click it.

♦ In the Assign Condition dialog, select (=) equal to from
the drop-down list as the Condition. Type “Active” as the
Value and click OK.

�� The next two conditional statements are based on information in
the OPPORTUNITY table. To have access to the fields in the
OPPORTUNITY table, you need to join it to the CONTACT
table.

♦ Scroll back to the top of the tree view, right click
CONTACTID, and select Create Local Join from the
shortcut menu.

♦ Click  in the Selected Table field and select
OPPORTUNITY. You don’t need to change the
Selected Field. Click OK to join the tables.

The Assign Condition
dialog opens
automatically when you
drop a field onto the
grid. To change a
condition or value,
open this dialog by
double-clicking the
statement you want to
edit.
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�� Now that the tables are joined, you can build the next two
conditional statements to find opportunities that you won since
January 1.

♦ Click  to open the CONTACTID/OPPORTUNITYID
join.

♦ Double-click ACTUAL CLOSE. Select (>=) greater
than or equal to as the Condition and 1/1/97 as the
Value. Click OK.

♦ In the tree view, scroll down to STATUS and double-
click. Select contains as the Condition and type Won as
the Value. Click OK.

�� That’s the last conditional statement. When you click OK, Query
Builder applies each statement against the database. The result is
your Stay in Touch group.

�� You can explore many other options when you use Query Builder:

♦ In addition to building a query that selects the
appropriate records, you can use the Defaults tab to set
options to filter the group based on account ownership
and to select only distinct records.

♦ The fields inserted in the Sorting Tab grid are based on
the type of Group you create (contact, account, or
opportunity). You can remove these fields or add new
fields. The fields on this tab determine the order in which
the group is displayed in the Contact List view.

♦ The Layout tab shows which fields are displayed in the
Contact List view. Several fields are automatically
included in the layout depending on the type of group
(account, contact, or opportunity). Select fields to help
you verify that the correct records were selected.

♦ On the Appearance tab, you can set the font of the group
title, the font and color of the fields displayed in the list,
and the highlight color and font of the selected list item.

Notice that each
statement has an entry
in the And/Or column.
Query Builder
automatically inserts
END for the last
statement and AND for
each of the other
statements. The AND
means don’t select the
record unless each of
these statements is
true. If you want to
select the record if any
of the statements are
true, you can change
the AND connector to
OR by right clicking and
selecting OR from the
shortcut menu. You
can use any
combination of AND
and OR to build a
query.
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To make sure you really do stay in touch with the group, attach a process
that generates a variety of letters, faxes, or e-mail over the next six months,
then schedule a phone call. Make sure the process includes a task that tests
the customer’s status before it sends correspondence. That way you won’t
look silly by sending a letter about purchasing when you might be working
on an opportunity with them or they don’t want to do business with you
anymore (perish the thought).

Related Help Topics

To learn: Open these topics:

About Query Builder Contacts

Find a Contact
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At Monday’s staff meetings, your manager always provides a
composite report for your sales team. You would like to have sales reports
for only your accounts, but you don’t want to tie up your system running the
reports. Order an agent to help you. You can ask your system administrator
to schedule an agent and deliver the reports to you.

��� ��� �	
�������� �� ����	��� �� �����

When you ask your system administrator to schedule an agent and run
reports for you, be sure you provide the following information:

♦ Name of the report(s)

♦ Name(s) of the group(s) you want to run the report on

♦ Date you want the report run

♦ If it’s a recurring report, the date you want to the report to
start, the frequency you want it run, and the date you want it to
stop

Your administrator may
have created a form
that you can use to
request scheduling of a
report agent. Check the
Sales Library to see if
such a form exists.
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When the administrator schedules an agent to run reports for you, the reports
are delivered via e-mail. Other users may also use e-mail to send you
reports. You use the Report Viewer to view and print reports from e-mail.

�� Log onto your e-mail system and open the message that contains
the report.

�� Double-click the report icon.

�� In the Report Preview view:

Click: To:

Adjust the on-screen view of the report

 or See previous or next pages of the report

Print the report

Save the report in a file

Open a previously saved report

Close the viewer

���� �� ����� ���

When you order reports, they are delivered via e-mail. Changes to accounts
and contacts and other documents and files are delivered to you via What’s
New.

What’s New information is organized on tabs. Some tabs apply to all users,
some apply only to remote users. For workgroup users, the New, Updated,
Deleted, and Conflict tabs display accounts and contacts you can access. For
remote users, the tabs display the accounts you subscribe to. Double-click a
record on a tab to see additional information.

To open What’s New, click  on the toolbar or select What’s New from
the View menu.

Tabs that apply to all users

If you are a remote
user, you can find
additional information
about What’s New in
Chapter 3, “If You
Work (Totally) Offsite.”
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New
Accounts
tab

Lists new accounts. If you are a workgroup user,
you see accounts to which you have access rights.
You can immediately work with any account in the
list. If you are a remote user, you must subscribe to
a record before you can work with it.

New
Records
tab

Lists new non-account or contact information
including opportunities, activities, and notes.

Updated
Records
tab

Lists accounts and contacts that were changed by
other users.

Deleted
Records
tab

Lists accounts, contacts, and other related records
deleted by other users.

Conflicts
tab

Lists accounts and contacts in which there was a
conflict.

Tabs that apply to remote users only

Delivered
Documents
tab

Lists Sales Library documents and document
attachments. Use the Sales Library to view the
library documents.

Other
Events tab

Lists other delivered files such as new software,
database, maintenance, and so on.

Related Help Topics

To learn: Open these topics:

How to view a delivered report Reporting

View or Print a Delivered
Report

About What’s New Managing Your Daily
Tasks

What’s New
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You’re reviewing the reports from Monday’s staff meeting and you
notice that another salesperson is working on a deal with another division
of the same company you have in the pipeline. When you pointed it out, the
boss asked you to associate the accounts so you could run a single report
on the whole company instead of separate reports for each division.

������ �� ���	
�� ���	�����	�

�� Open the Account Detail view for the account you want to create
an association for.

�� Click the Associations tab in the Account Detail view.

�� With the cursor positioned in the Associations tab area, right click
and select Associate an Account from the shortcut menu.

�� In the Lookup dialog, double-click the account you want to
associate to the selected account.

�� Select the type of association from the drop-down list for each
account. To add a new type, click Add and enter a name in the
Add List Item dialog.

�� Enter a description for each account.

	� Click OK.

����� ����	�� 	
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You can also use associations to create a relationship between contacts
within the same account or across different accounts. For example, if Bill
Hickman works for ABC Inc., and sells products to Wayne Clark, who
works for XYZ Ltd., a buyer/seller association exists between them. If
Sally Smith works for Jean Hickman, an employee/employer relationship
exists between them. (Bill Hickman and Jean Hickman may be related,
but that’s not the kind of association we’re talking about.) Associations
are listed on the Associations tab in the Contact Detail view.
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Related Help Topics

To learn: Open these topics:

How to associate accounts Accounts

Associating Accounts

How to associate contacts Contacts

Associating Contacts
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����� SalesLogix supports both workgroup users and remote users. If you
are a workgroup user, you have a direct connection to the workgroup
database. You do not store a database locally on your computer. You do not
need to review this section of the user’s guide.

If you are a remote user, you will want to store a subset of the data in the
workgroup database on your computer so it is readily available. SalesLogix
provides two primary tools to ensure you get the information you need. To
update the changes you make locally and to receive changes made to the
workgroup database, you use synchronization. To identify the information
you want to receive, you use subscription.

��������

When you are added to
the system, the system
administrator
determines if you are a
workgroup user or
remote user.
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Your company is expanding its sales force to the west coast and you’ve
been asked to relocate. The incentive? Aside from great weather, once the
office is fully functional, there’s a good chance you’ll be promoted to
regional manager. You’re nervous about being so far from headquarters
and depending on your notebook computer to keep you in touch. You’ve
had only two days of training…but there’s no need to worry. SalesLogix
has the tools to keep you in synch with what’s happening at the home office.

���� �� ��	
���	�����	�

Basically, synchronization links remote users to the workgroup database.
As a remote user, you have a subset of the workgroup database stored
locally on your computer. When you make changes to your local
database, the changes are recorded in a transaction exchange file. When
you synchronize with the workgroup database:

♦ Your computer connects to the Workgroup Server using Dial-
up Networking, a network connection, or e-mail.

♦ Your transaction exchange files are sent to the Workgroup
Server and archived.

♦ The Workgroup Server transaction exchange files are sent to
you. These files contain changes made to the network database
by other remote and workgroup users, sales library requests,
reports, software updates, and so on. You only receive changes
to accounts to which you subscribe.

♦ Your computer disconnects from the Workgroup Server.

♦ The Workgroup Server transaction exchange files are applied to
your database and archived.

♦ Your changes are applied to the network database. As the files
are applied, they are checked for conflicts. Conflicts are
resolved based on conflict resolution rules. After the files are
applied, they are archived.
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�� Select Synchronize from the File menu or click  on the toolbar.

�� In the Synchronization dialog, check Disconnect When Done if
you want synchronization to terminate your connection after it
sends and receives files, but before it applies received files. Select
this option to minimize the connection time.

�� Set the synchronization options.

♦ Contact your system administrator to find out which
connection method you should select.

♦ Check all the other options unless you are instructed
otherwise.

�� Click  to close the options section.

�� Specify when you want to synchronize.

To synchronize now:

♦ Click . Each step of the synchronization
process is shown in the Synchronization Status box.

♦ Click  to start applying transaction exchange
files to your database. If you checked the Apply changes
after transfer option, this is automatic.

 As transactions are applied to your database, the Apply
Changes to Local Database dialog counts the number of
transactions already processed, the total number of
transactions to process, the elapsed time, and the time
required to apply the remaining transactions.

♦ Click OK to confirm apply.

To synchronize later:

♦ Click .

♦ Click . The color of the digital
display changes from green to gold.
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♦ Set the digital display to the time when you want to

initiate Synchronization. Use  to adjust the time (in
the 24-hour clock, 22:30 represents 10:30 PM) in the
digital display.

♦ Do not close the Synchronize dialog. Make sure you
are connected to a phone line or have an active
network connection.

�� Resolve errors and review What’s New.

♦ If you see the Synchronization Error dialog, contact your
system administrator for information about resolving the
error.

♦ Review What’s New to see if you received any of the

following items. To open What’s New, click  on the
toolbar or select What’s New from the View menu.

To check for: Click this tab:

New accounts you can subscribe to New Accounts

Other new items such as notes,
opportunities, activities, and so on

New Records

Accounts and contacts you
subscribe to that were changed by
other users

Updated Records

Accounts, contacts, and other
related records deleted by other
users

Deleted Records

Conflicts for accounts and contacts
you subscribe to

Conflicts

Sales Library requests and attached
documents

Delivered Documents

Other files Other Events
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After you synchronize and disconnect from the Workgroup Server, you
can edit records that also exist in the network server database. Because
records that reside on both the network server database and remote
databases can be changed independently, a mechanism is needed to
decide which changes are valid. The Conflict Resolution component of
synchronization decides which change wins. The administrator can
identify up to three criteria to determine which user wins when a conflict
occurs. After analyzing the two conflicting transactions a win, loss, or tie
occurs. In the event of a tie, the next criteria is used to attempt to settle
the tie and so forth. Generally, if all other options are exhausted and the
transactions are still in conflict, the system allows the most recent
alteration to prevail. Conflict are resolved when changes are applied to
the network database, not the remote database.

If your change is in conflict, you receive notification of the outcome on
the Conflicts tab in What’s New. Ask your administrator for information
about your rules.

���� � �	��
������

Typically, you have access to a subset of all the information in the
company database. However, you will not need much of the data that you
have access to on a regular basis. You can use subscription to select, or
subscribe to, the accounts you use on a regular basis and want to store on
your local database. Using subscription minimizes the database size on
your computer and the time required to transmit synchronized data.

If you need a report that includes data which is not stored on your local
database, you can ask the administrator to schedule a Report Agent. The
Agent Scheduler can generate and deliver a report that includes all the
data stored on the network database to which you have access rights.

Both you and the administrator can specify the accounts you subscribe to,
as well as establish your subscription rules. When you or the
administrator indicate you want to subscribe to an account, the request is
transmitted the next time you synchronize. Use the Subscription Manager
or What’s New to subscribe to accounts and to set subscription rules.
There are three general rules that govern subscription:
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♦ You automatically subscribe to the accounts you own as an
individual.

♦ You automatically subscribe to accounts you own as the primary
member of a team.

♦ Users defined in your default security profile can subscribe to the
accounts you own as an individual or as a member of a team. Your
default security profile defines your ability to access information
related to an account, other users who share access to your accounts,
and your ability to create and maintain teams.

���	
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From the What’s New window:

�� Select What’s New from the View menu.

�� Click the New Records tab or the Updated Records tab.

�� Select a record and click .

You cannot subscribe to accounts preceded by .

�� Click Yes to confirm subscription.

Related Help Topics

To learn: Open these topics:

About synchronization Remote User Features

What Is Synchronization?

About conflict resolution Remote User Features

What Is Conflict Resolution?

About subscription Remote User Features

What Is Subscription?

You can also subscribe
to accounts and
unsubscribe using the
Subscription Manager.
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Each view in your SalesLogix workspace contains many of the same
elements.

♦ Title Bar:  Identifies the active SalesLogix feature. When you
are in the Account, Contact, or Opportunity views, it also
displays the name of the current account, contact, or
opportunity.

���	�����
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♦ Menu Bar: Contains the SalesLogix menus. You use the
items on each menu to access SalesLogix features. Each menu
item has a speed key, which is the underlined letter in the item
name. For example, to print a report you can open the File
menu and then press R. Shortcut keys appear to the right of
some menu items; you can press these keys to activate the
feature. For example, to open e-mail, press CTRL+F7. Use
the Customize item on the Tools menu to add or remove
menu items.

♦ Toolbar: Contains buttons that you click to open the most
frequently used SalesLogix features. You can use the
Customize item on the Tools menu to add buttons, create new
toolbars, and hide toolbars.

♦ Splitter Bars: Used to change the size of a column or a
section of a view. Move the mouse pointer to the border of a
view section or column. When the double-arrow cursor
appears, drag the line to the desired position. To restore the
splitter bars to the previous position, select Restore Splitters
from the Window menu.

♦ Tabs: You can customize the tabs in many SalesLogix views
and dialogs. .

To: Do this:

Rearrange the order of
tabs

Drag a tab. When the cursor

changes to , drop the tab in a
new position.

Hide a tab Select a tab. Right click and select a
tab from the shortcut menu. Tab
names that are checked are visible.

Move a tab to the middle
of the Detail view

In the Account, Contact, or
Opportunity Detail view, select a
tab and drag it to the middle of the
view. When the cursor changes to

, drop the tab in its new
position.

The menu items
available to you are
based on your access
rights.

The toolbar buttons
available to you are
based on your access
rights.
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♦ Navigation Bar: Located on the left side of the SalesLogix
screen. It contains a series of buttons that open the major
SalesLogix views: Contacts, Accounts, Opportunities,
Calendar, Activities, Sales Library, Reports, and Processes.
Click  or  at the top and bottom of the
navigation bar to move the bar up or down. Click the arrows
to the right of a selected icon to move to the next or previous
account, contact, or opportunity.

♦ Tree Views: Lists of
items organized into
categories. Click  or

 to expand or collapse
the tree view. Use the
scroll bar to scroll
through the expanded
list.

♦ Status Bar: Displays the current date, user, and application.
Status Bar icons indicate if you are logged onto e-mail  or
not . Right click an icon to open a shortcut menu. You can
hide or show the Status Bar by selecting Status Bar from the
View menu.

The navigation bar
buttons available to you
are based on your
access rights.
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You can control a variety of SalesLogix features by setting options that
reflect the way you work. You can personalize your workspace by choosing
colors and fonts and setting up your calendar display to match your
workday. To make features you use frequently easy to access, you can add
and delete items from toolbars and menus. You can also set specific
preferences for a variety of features, including the view that appears when
you start SalesLogix and the prompts you see when scheduling activities.

In some cases, you must specify your preferences before you can use a
SalesLogix feature. To send faxes from within SalesLogix or to use e-mail,
you must set the fax provider and e-mail options. To use form letters, you
need to set the default document templates for the items on the Write menu.

Once you become familiar with SalesLogix, take some time to explore these
options and experiment with different settings.
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You can set several options to activate SalesLogix features automatically
when you start the program. To set these options, select Options from the
Tools menu and set each option as shown in the following table.

To: Click this tab: And:

Select the view that
appears when you start
SalesLogix

General Select a view from the
Show On Startup drop-
down list.

Select the group that is
current when you open
the Account, Contact,
or Opportunities view

Main View Select a group from the
Contacts, Accounts,
and Opportunities
drop- down lists.

Select the default
owner for all accounts
you create

Main View Select an owner from
the drop-down list.

Preserve changes you
make in your view grid
layouts

General Make sure the Save
Grid Layouts check
box is selected.

Display a confirmation
message before you
delete an item

General Check the Confirm
Deletions check box.

Run processes when
you start SalesLogix

System Check the Run Process
Manager on Startup
check box.

Automatically roll over
overdue activities to
the next day

Activities Select an activity type
and then check the
Rollover on startup
check box. When you
start SalesLogix, the
Activity Manager
dialog displays the
overdue activities you
can roll over.
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To change colors and fonts in your workspace and hide or display Tool
Tips:

♦ Select Options from the Tools menu, and click the General
tab.

♦ You can select colors for the navigation bar, view title bars,
the current day in the Day and Month views of your calendar,
and the highlight used for days with scheduled activities in the
month displays on the Day view.

 Open the drop-down list in each field to see the available
colors. Select a color and click OK. When you click OK to
close the Options dialog, the new colors are displayed in your
workspace.

♦ You can select fonts for the text display in the view title bars
and for clickable text.

 Open the drop-down list in each field to see the available
fonts. Set the font options and click OK. When you click OK
to close the Options dialog, the new fonts are displayed in
your workspace.

♦ To hide or display
Tool Tips—the brief
descriptions that pop
up when you move
the mouse pointer
over a button—check or clear the Hide Tool Tips check box.

To change the colors of the toolbars in your workspace:

�� Right click in a toolbar and select Properties from the shortcut
menu.

�� Click the Color tab.

�� Select a color for the toolbar and a color for the toolbar docking
area. The default color for both is BtnFace (gray).

�� Click OK to see the new colors.
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To rearrange the toolbars in your workspace:

�� Click a toolbar (do not click a button) and drag it out of the toolbar
docking area.

�� Change the toolbar orientation from horizontal to vertical by
moving the mouse pointer to the edge of the toolbar. When the
mouse pointer becomes a double-arrow, you can drag horizontally
or vertically to change the orientation.

��� ���� 	
������ 	� �
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�� Select Options from the Tools menu.

�� Click the General tab.

Check: To:

Disable Alarms Eliminate notification of upcoming
activities.

Check
Availability

Have SalesLogix check your calendar for a
previous commitment before adding an
activity to your schedule.

Confirm Event
Reschedule

See a confirmation prompt when you
reschedule an event.

�� Click the Activities tab and select an activity type. For each type of
activity:

♦ Set the items you want to be prompted to enter when
scheduling an activity. For example, if you select
Meetings and set Date to Month, SalesLogix displays a
mini-Month view, including lists of scheduled events and
activities, when you schedule a meeting. You select the
date you want on the calendar. If you set Date to
Calendar, you see only the calendar portion of the Month
view; if you set it to Week, you select a date from the
Week view. If you choose Off, no prompt for the date is
displayed. It’s a good idea to turn on these prompts so
you don’t forget to enter information when you schedule
an activity.
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♦ Check the Rollover on startup check box to transfer
overdue activities to the next day. When you start
SalesLogix, the Activity Manager dialog informs you of
any activities that were not completed at their scheduled
time.

♦ In the Default Alarm Settings area, set the length of time
before an activity that you want to receive notification. If
you check the Enabled when created option, the alarm
settings are automatically filled in whenever you
schedule the selected type of activity.

��� ���� 	
���
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�� Select Options from the Tools menu and click the Calendar tab or
right click in any Calendar view and select Options from the
shortcut menu.

�� Set the following options:

Drag Default In the Day and Week views, when you
click the timeline and drag, SalesLogix
assumes you want to schedule an activity.
If you usually schedule one type of activity,
select it from the Drag Default drop-down
list; SalesLogix displays the Schedule
dialog for that activity when you click and
drag on the timeline. If this option is set to
Choose, SalesLogix displays a dialog so
you can select Meeting, Phone Call, or To-
do.

Days of History
to Show

Specify how many days of history to
display on the Calendar.

Double-click Choose to open the Contact view or the
Edit Activity dialog when you double-click
a scheduled activity.

Month Displays Choose Activity List to display specific
activities or Day at a Glance to display a
mini-timeline of each day in the Month
view.
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Calendar
Shows

Choose Month only to display only the
current month or 5 week view to display the
month plus the adjacent weeks in the
Month view.

Go To Contact If you are in the calendar with an activity
selected, you can right click and select Go
To Contact from the shortcut menu to open
the Contact Detail view for the contact
involved in the activity. Choose Create
Lookup to go to the Contact view and
create a lookup where the contact in the
activity is the only active contact. Choose
Use All Group to go to the Contact view
with the All Contacts group active.

�� Define your work week by selecting the check boxes for the
appropriate days in the Work Week area and entering Day Start
and Day End times in the Calendar Display area. The time period
you select for each selected day is displayed with a white
background in your calendar; days and times outside of your
selection have a gray background. You can schedule activities in
the white or gray areas.

�� In the Activity Display area, select the items you want to see listed
for each scheduled activity in the Day and Week views.

�� In the Calendar Display area, select the:

♦ combination of gridlines you want to display.

♦ day you want to start the week in each view of the
calendar.

♦ type of week bars you want to display in the Month view.
You can choose: Off, Buttons, Numbers, or Numbers
and Text. When you click a button, it takes you to the
associated Week view.
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♦ When you initiate a lookup using the Lookup dialog, you can
either display a list of items when you open the dialog or
display an empty dialog. To display a list of items, select
Options from the Tools menu. On the Main View tab, check
the Auto Query on Open option in the Lookups area. If you
are working with a group or the result of a lookup, and check
the Within Current Group/Lookup option in the Lookup
dialog, the list you see represents the current group.

♦ If you want lookups to be case sensitive (include
capitalization when matching), select the Case Sensitive
Lookups check box.

♦ To confine lookups to the current group, check the Within
Current Group/Lookup option.

��� ���� ���������� ������

When you add an opportunity, you enter information about the contacts,
competitors, and products related to the opportunity. Use the Opportunity
Wizard options to specify the order in which you are prompted for this
information.

�� Select Options from the Tools menu.

�� Click the System tab.

�� In the Opportunity Wizard fields, choose the items you want
shown first, second, and third from the drop-down list in each
field, or select None if you do not want to be prompted to enter
information.

�� Click OK to save the option settings.
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�� To set your process options, select Options from the Tools menu
and click the System tab in the Options dialog, or select Processes
Scan Interval from the Tools menu.

�� Set your Process Manager options.

Click: To:

Run Process
Manager on
Startup

Scan your active processes each time
you open SalesLogix.

Execute VBA
Scripts within
Processes

Execute any VBA Scripts attached to a
process.

Scan Processes
every X minutes

Scan your active processes every X
minutes.

�� Click OK.
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You can use the SalesLogix word processor to work with templates or to
create documents from scratch. The word processor provides tools you can
use to manage, edit, format, and produce documents.

To use the SalesLogix word processor, make sure it is selected as your
default word processor. (Choose Options from the Tools menu and click the
System tab.) To open the word processor, select a document from the Write
menu. When you finish using the word processor, select Close from the File
menu or click the close box to return to SalesLogix.

You can work with documents created in other word processors by saving
them as .rtf files, opening them in SalesLogix, and then editing them. If you
do this, you may need to reformat the document in the SalesLogix word
processor.

���	������
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Use the items on the SalesLogix word processor File menu to create a new
document, open an existing document, or save a document or template.

Choose: To:

New Create a new document. The current document or
template is replaced by a blank page. You cannot add
merge fields to a document. If you want to add fields,
you must use a template.

Open Open an existing document. You can open any
document that is saved as an .rtf file.

Save Save a document.

Save As Save the document under a new file name.

������ ������� �� ��� � ��	
����

After you compose a letter, memo, or fax, use the items on the SalesLogix
word processor File menu to print, send, or fax the document.

Choose: To:

Printer Setup Change the default printer setup for the SalesLogix
word processor.

Print Preview See how the document looks when printed. Click
Close to return to the document.

Print Print the document using your printer settings.

E-mail E-mail the document to the contact.

FAX Fax the document to the contact.

If e-mail and fax are not
enabled on your
system, these options
do not appear on the
menu.
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Use the items on the Edit, View, and Insert menus to edit a document or
template.

Choose: To:

Edit Menu

Cut Remove the selected text from the document and
place it on the clipboard.

Copy Place a copy of the selected text on the clipboard.

Paste Insert the contents of the clipboard into the document.

Select All Select the entire content of the document.

Find Search the document for a word or phrase.

Replace Search the document for a word or phrase and replace
it with other text.

View Menu

Merge Fields Add merge fields to a template.

Ruler Turn the ruler display on or off.

Insert Menu

Page Break Insert a dashed line to indicate a page break.
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You can insert any bitmap graphic into a document or template.

�� Position the cursor at the location where you want to insert the
picture.

�� Select Picture from the Insert menu.

�� In the Open Graphic File dialog, select the picture you want to
insert and click OK.

�� When the picture appears on the page, double-click to select it.

�� To size the picture, drag the size box in the lower right corner.

�� To position the picture, use the Alignment and Paragraph items on
the Format menu, or press the TAB key.

������ � ������� �� ���	����

Use the items on the Format menu to set up page layout and select fonts and
text styles. You can apply formats to selected text or to merge fields.

Choose: To:

Style Apply a text style to the selected text or merge field.

Alignment Align the selected text, merge field, or picture.

Font Select a font, font style, font size, strikethrough, or
underline effects, and color for the selected text or
merge field.

Paragraph Set indents and spacing for the selected paragraph.

Page Choose the paper size and set margins.
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�� From the SalesLogix word processor, select Spelling from the
Tools menu, right click and select Spelling from the shortcut
menu, or press F7.

SalesLogix scans the document. When it finds a word it doesn’t
recognize, it appears in the Not found field of the Spelling dialog.

�� Type the correct spelling of the word in the Change To field or
double-click a word from the list of suggestions. Or:

Click: To:

Ignore Leave the word as it currently appears.

Ignore All Leave all occurrences of the word in the
document as they currently appear.

Change Change the word to the spelling you
entered in the Change To field.

Change All Change all occurrences of the word to the
spelling you entered in the Change To field.

Add Add the word to your personal dictionary.

Cancel Stop the spelling check and return to the
document.

�� Continue to correct words until the entire document has been
checked.
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SalesLogix gives you a choice of using the SalesLogix word processor or
Microsoft Word to prepare correspondence. Before you can use Word, it
must be your selected word processor. Be sure you are using Microsoft
Word for Windows ’95 version 7.0 or later.

When you use Word with SalesLogix:

♦ You must use the SalesLogix word processor to build templates. If
you want to use text from another document as the basis for a
SalesLogix template, you can save the document as an .rtf file and
open it in SalesLogix. This will preserve the text, but not the
formatting, because the SalesLogix word processor does not
support all .rtf formatting features. You will need to reformat the
document in SalesLogix. You can also copy text from any
document to the Windows clipboard and paste it into a SalesLogix
template.

 To load text from a Word .rtf file:

�� Save the document as an .rtf file in Word.

�� In SalesLogix, select Templates from the Write menu and click

.

�� With the Document view open, select Load Template from File
from the File menu. Find the document you saved as an .rtf file and
click Open. Add merge fields to the document and save it.

�� Make any necessary changes.

�� Name the template, select the family (folder) where you want to
save it, and assign yourself as the owner.

����������
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To use the template, select it as one of the default templates. When
you select the template from the Write menu, SalesLogix opens
Word. The selected template is displayed with the merge fields
containing information about the current contact.

♦ When you save a document in Word, it is saved in the directory
you specify in Word and a history item is entered for the contact in
SalesLogix.

♦ If your e-mail and fax software is “Word enabled,” you can fax or
e-mail a SalesLogix document directly, just as you would send any
other document from Word. Documents you fax or e-mail are
recorded as history items in SalesLogix.
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types, 5
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adding notes, 30
associating, 60
defined, 5
groups, 19
notes, 29
owning, 8
subscribing to, 68
viewing, 6
viewing help, 9
What’s New, 58
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completing, 32, 35, 42
defined, 11
displayed in the calendar, 11
follow-up, 33
history, 11
personal, 11
resources, 11
scheduling, 12, 27
scheduling follow-up, 35
scheduling for other users, 13
scheduling personal, 17
scheduling recurring, 12
setting alarms, 11
setting options, 12, 27, 28, 76
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viewing, 44
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viewing help, 14, 28
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scheduling, 57
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Month view, 4
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defined, 67
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adding personal, 15
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attaching processes, 48
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involvement in opportunities, 36
notes, 29
sending e-mail, 40
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sending faxes, 16
sending literature, 26
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viewing, 6
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